Evaluation and integration of tools for the development of web based course ware

Miguel Bosch

2008-06-09
Evaluation and integration of tools for the development of web based course ware

Examensarbete utfört i datavetenskap vid Tekniska Högskolan vid Linköpings universitet

Miguel Bosch

Handledare Bengt Lennartsson
Examinator Bengt Lennartsson

Norrköping 2008-06-09
Upphovsrätt

Detta dokument hålls tillgängligt på Internet – eller dess framtida ersättare – under en längre tid från publiceringsdatum under förutsättning att inga extra-ordinära omständigheter uppstår.

Tillgång till dokumentet innebär tillstånd för var och en att läsa, ladda ner, skriva ut enstaka kopior för enskilt bruk och att använda det oförändrat för ickekommersiell forskning och för undervisning. Överföring av upphovsrätten vid en senare tidpunkt kan inte upphäva detta tillstånd. All annan användning av dokumentet kräver upphovsmannens medgivande. För att garantera äktheten, säkerheten och tillgängligheten finns det lösningar av teknisk och administrativ art.

Upphovsmannens ideella rätt innefattar rätt att bli nämnd som upphovsman i den omfattning som god sed kräver vid användning av dokumentet på ovan beskrivna sätt samt skydd mot att dokumentet ändras eller presenteras i sådan form eller i sådant sammanhang som är kränkande för upphovsmannens litterära eller konstnärliga anseende eller egenart.

För ytterligare information om Linköping University Electronic Press se förlagets hemsida http://www.ep.liu.se/

Copyright

The publishers will keep this document online on the Internet - or its possible replacement - for a considerable time from the date of publication barring exceptional circumstances.

The online availability of the document implies a permanent permission for anyone to read, to download, to print out single copies for your own use and to use it unchanged for any non-commercial research and educational purpose. Subsequent transfers of copyright cannot revoke this permission. All other uses of the document are conditional on the consent of the copyright owner. The publisher has taken technical and administrative measures to assure authenticity, security and accessibility.

According to intellectual property law the author has the right to be mentioned when his/her work is accessed as described above and to be protected against infringement.

For additional information about the Linköping University Electronic Press and its procedures for publication and for assurance of document integrity, please refer to its WWW home page: http://www.ep.liu.se/

© Miguel Bosch
Acknowledgments

I hereby wish to thank the Linkoping University for bringing me the opportunity for having an unforgettable experience and also for finishing my studies in such excellent institution.

I would like to thank to my teacher Bengt Lennartsson and my coordinator Nuria Castell to bring me all their support and for being so patient with me every time.

I want also to thank to my work colleagues from Nokia to his continuous help, in special to Karen Agger and Jens Carlsson.

Many thank my friends Abel Muries, Jonathan Gonzalez and Miguel Angel Garcia Jimenez to be always there and to be my best friends.

Thanks to Enrique Marina Herranz to his fabulous ideas and to Anna Gomez de Aranda Celades to her help with the English and to love me.

And my last and more special thanks are to my family in special my sister Cristina Bosch Orea that is my heart and my mother Josefa Orea Luque that she has been supporting me not only in this thesis, all my life, I really want to thank to her because she is the reason to be happy all the days.
1. GOALS AND OBJECTIVES ........................................................................................................... 5
2. BACKGROUND ............................................................................................................................. 7
   2.1 What is eLearning? ................................................................................................................. 7
   2.2 What is a Learning Object? .................................................................................................... 8
   2.3 Traditional classroom teaching VS Web based distance learning .................................... 9
   2.4 Advantages and Drawbacks of using the Web in teaching .................................................. 10
      2.4.1 Advantages of using the Web in teaching ................................................................. 10
      2.4.2 Drawbacks of web usage in distance learning ....................................................... 11
   2.5 Advantages of eLearning in the enterprise ......................................................................... 12
   2.6 E-Learning in an economic point of view ........................................................................... 13
   2.7 E-Learning needs analysis ..................................................................................................... 14
3. METHODS ......................................................................................................................................... 15
   3.1 Tools for creating e-Learning content ................................................................................ 15
   3.2 E-Learning System Tools .................................................................................................... 17
      3.2.1 Web Servers .................................................................................................................. 18
      3.2.2 LMS ............................................................................................................................... 18
      3.2.3 LCMS ............................................................................................................................ 19
      3.2.4 Collaboration tools ...................................................................................................... 20
      3.2.5 Virtual Schools ............................................................................................................ 21
      3.2.6 Media Servers .............................................................................................................. 22
   3.3 Standards in ELearning ......................................................................................................... 22
      3.3.1 Interoperability and compatibility ................................................................................ 24
      3.3.2 Institutions of specifications and standards ................................................................. 24
      3.3.2.1 W3C World Wide Web Consortium ........................................................................ 25
      3.3.2.2 IEEE / LTCS Working and Study Groups ............................................................... 25
      3.3.2.3 AICC Aviation Industry CBT Committee ............................................................... 26
      3.3.2.4 ADL Advanced Distributed Learning Initiative ................................................... 27
      3.3.2.5 The initiative ADL SCORM ..................................................................................... 27
      3.3.2.6 IMS ............................................................................................................................ 28
4. THE ALTERNATIVES ..................................................................................................................... 29
   4.1 Technology .............................................................................................................................. 29
   4.2 Choosing a LMS ..................................................................................................................... 29
   4.3 Choosing a tool to create ELearning content easily ............................................................ 30
      4.3.1 What is Flash? ................................................................................................................ 31
      4.3.2 What is Powerpoint? .................................................................................................... 32
      4.3.3 What is a Powerpoint presentation? ............................................................................ 32
      4.3.4 Main reasons to convert a PowerPoint file into a Flash file ..................................... 32
   4.4 Manual Instructions .............................................................................................................. 34
      4.4.1 ARTICULATE. [17] ....................................................................................................... 35
      4.4.1.1 How to use Articulate? ............................................................................................. 35
      4.4.1.2 Narration and audio ................................................................................................. 36
      4.4.1.3 Import Audio ............................................................................................................ 38
      4.4.1.4 Sync Animation Timings ........................................................................................ 39
      4.4.1.5 Timeline Audio Editor ............................................................................................. 40
      4.4.1.6 Library and options ................................................................................................. 42
         4.4.1.6.1 Logos .................................................................................................................. 43
         4.4.1.6.2 Presenters ............................................................................................................ 44
         4.4.1.6.3 Playlists .............................................................................................................. 44
         4.4.1.6.4 Quality ................................................................................................................. 45
         4.4.1.6.5 Other .................................................................................................................... 46
      4.4.1.7 Slide Properties Manager ....................................................................................... 47
      4.4.1.8 Quizzes and Learning Games .................................................................................... 49
      4.4.1.9 Engage Interactions ................................................................................................. 54
4.4.1.10 To add a Flash Movie .......................................................... 55
  4.4.1.10.1 Configuring Flash Movie to display in Slide......................... 57
  4.4.1.10.2 Configuring Flash Movie to display in presenter panel........... 59
  4.4.1.10.3 Configuring Flash Movie to display in new browser window..... 60
4.4.1.11 Inserting Web Objects .......................................................... 61
4.4.1.12 Attachment ........................................................................ 64
4.4.1.13 Player Template Builder ....................................................... 65
  4.4.1.13.1 Layout ........................................................................ 66
  4.4.1.13.2 Navigation .................................................................... 67
  4.4.1.13.3 Text Labels .................................................................... 68
  4.4.1.13.4 Colours ........................................................................ 68
  4.4.1.13.5 Other ............................................................................ 69
4.4.1.14 To publish your presentation .................................................. 70
  4.4.1.14.1 Publishing for Web delivery ............................................ 71
  4.4.1.14.2 Publish to Articulate Online ........................................... 72
  4.4.1.14.3 Publish for LMS .............................................................. 74
  4.4.1.14.4 Publish for CD .............................................................. 75
  4.4.1.14.5 Publish to Word............................................................. 76
  4.4.1.14.6 Publish to Project Files .................................................. 77
4.4.1.15 View Presentation ................................................................ 78
4.4.2 TURBODEMO [16] ..................................................................... 80
4.4.2.1 Capturing ............................................................................. 81
4.4.2.2 Editing .................................................................................. 85
  4.4.2.2.1 Thumbnail Mode / Slide View Mode .................................... 85
    4.4.2.2.1.1 Project Options ......................................................... 86
    4.4.2.2.1.2 Insert Sound .............................................................. 87
    4.4.2.2.1.3 Add an image ............................................................ 88
    4.4.2.2.1.4 Slide Transitions ...................................................... 89
    4.4.2.2.1.5 Adding Objects and actions to a slide ......................... 90
  4.4.2.2.2 Single Slide Mode ............................................................ 91
    4.4.2.2.2.1 Description Notes ..................................................... 92
    4.4.2.2.2.2 Animations ............................................................... 93
    4.4.2.2.2.3 Interactive functions ................................................. 94
    4.4.2.2.2.4 Question and Answer (Quiz) ...................................... 95
4.4.2.3 Publishing ........................................................................... 96
  4.4.2.3.1 Generate a FLASH (SWF), EXE (Standalone) or JAVA (Applet)... 97
  4.4.2.3.2 GIF-Animation and Windows Media Player (ASF) ................ 98
  4.4.2.3.3 Word Document ............................................................ 99
  4.4.2.3.4 PDF Document ............................................................. 99
  4.4.2.3.5 Images (BMP, GIF, JPEG) ............................................. 100
  4.4.2.3.6 Resize the Project .......................................................... 101
4.4.3 CAMTASIA STUDIO [18] ........................................................... 102
4.4.3.1 Welcome dialog ..................................................................... 103
  4.4.3.1.1 Audio Settings .............................................................. 104
  4.4.3.1.2 Camera Settings ........................................................... 106
  4.4.3.1.3 Recording .................................................................... 107
  4.4.3.1.4 Working with PowerPoint .............................................. 110
4.4.3.2 TimeLine View or Main View .................................................. 112
  4.4.3.2.1 TimeLine ....................................................................... 113
  4.4.3.2.2 Storyboard .................................................................... 114
  4.4.3.2.3 Special Effects and Enhancements .................................... 115
  4.4.3.2.4 Record Camera: Add a Picture-in-Picture Recording .............. 115
  4.4.3.2.5 Voice Narration ............................................................. 116
  4.4.3.2.6 Modify a Picture-in-Picture Recording .............................. 117
4.4.3.2.7 PIP Preview.................................................................117
4.4.3.2.8 Audio Enhancements.........................................................118
4.4.3.2.9 Transitions........................................................................118
4.4.3.2.10 Callouts........................................................................119
4.4.3.2.11 Zoom-n-Pan .....................................................................120
4.4.3.2.12 Flash Quiz & Survey..........................................................121
4.4.3.2.13 Captions........................................................................122
4.4.3.2.14 Add Metadata Using the Project Properties .......................123
4.4.3.3 Producing video......................................................................124
  4.4.3.3.1 Recommend my production settings......................................125
    4.4.3.3.1.1 Optimize File Size or Video Quality ..............................127
    4.4.3.3.1.2 Optimize for File Size or Audio Quality .........................128
    4.4.3.3.1.3 Flash Templates ............................................................128
    4.4.3.3.1.4 Table of Contents ..........................................................130
    4.4.3.3.1.5 Produce Multiple Files..................................................130
    4.4.3.3.1.6 Save your video ..............................................................131
    4.4.3.3.1.7 Completing your Production ............................................132
    4.4.3.3.1.8 Production Complete .......................................................133
    4.4.3.3.1.9 Production Results........................................................134
  4.4.3.3.2 Production Presets ............................................................134
  4.4.3.3.3 Custom Production Settings ..............................................136
    4.4.3.3.3.1 Encoding Options..........................................................138
    4.4.3.3.3.2 Video Size......................................................................140
    4.4.3.3.3.3 Video Options .................................................................140
    4.4.3.3.3.4 Marker Options..............................................................141
  4.4.3.3.4 Produce Video ...................................................................142
    4.4.3.3.4.1 Batch Production..........................................................143
    4.4.3.3.4.2 Package a Video as a Pack and Show Executable File ........143
4.4.3.4 Other Applications in Camtasia Studio ....................................144
  4.4.3.4.1 Camtasia Recorder.............................................................144
  4.4.3.4.2 Camtasia Audio Editor.........................................................146
  4.4.3.4.3 Camtasia MenuMaker..........................................................146
  4.4.3.4.4 Camtasia Theater .................................................................148
  4.4.3.4.5 Camtasia Player .................................................................149
5. RESULTS .........................................................................................150
6. CONCLUSIONS..............................................................................151
7. REFERENCES.................................................................................152
1. GOALS AND OBJECTIVES

In the old days the learning methods were based on the charisma and wisdom of the teachers and hard study sessions of the students. The times now have changed and different and improved techniques have emerged into universities, private schools and also virtual schools.

In this document we will go through all those tools, techniques that have made it possible to develop the new ways of learning. How the old methods can be substituted by a faster, more clear and more efficient way of teaching.

At the beginning of the project the idea about this issue was clear. It was mostly about showing those methods I saw in universities and also in private English schools in Spain. But when we were digging into this theme, I realized how many different branches about this were growing and also the amount of information I had to read to understand the whole.

The eLearning is a form of distance education which has emerged with the development of new information technology and Internet. It consists of taking advantage of the ease of distribution of educational material and communication tools offered by the network to create an environment for learning.

Through this technology students have access to courses and interactive multimedia Web format, supported by media that enable collaboration and online discussion of the subjects studied. This means to that training is tutored by an expert to monitor the progress of students, as well as guidance, resolving doubts, motivation, etc...

Also there is a really important economic impact on how the actual companies train the employees, with a system that creates a shortage of skilled workers, especially in those companies with global teams, highly qualified professionals or telecommunications related.

eLearning solutions facilitate the delivery of the right information and skills to the right people at the right time. That is the main goal.

One of the objectives of this study is to choose tools to create web courses easily for teachers in a practical method without the complexity of building a sophisticated eLearning system; it can cost a lot of resources, money and time. Therefore the included manuals will be helpful information for the readers and also a quick way of showing differences and advantages of each of the tools and also a quick reference related with eLearning.

I have based my selection on trying to find the best tools that allow working with the most used tool to generate presentations that in my opinion is PowerPoint. Also having the possibility to record the screen, to add narration, video and to have the possibility to edit all these features.
The possibility to create FLASH format was also important as it is the most used in the web contents and at the same time to have another conversion possibilities like .AVI, .MPG or just finding the best way to add the eLearning content via CD.

But all these methods (Flash, PowerPoint, sound, video…) can be improved by the tools presented in this document. They are able to combine and optimize the efficiency and effectiveness due to all the elements included inside the eLearning standards, giving as a result the most flexible way of making eLearning courses.

In this document I will speak about the different options to generate eLearning material (tools, systems, standards) and I will present three of the main tools to make eLearning courses easily, three tools to the readers of the manual, specially aimed at teachers so they can try by themselves all of them and choose the one they like most.

These tools are Camtasia Studio, Articulate and TurboDemo, which will be the most interesting parts of this project, filling the practical part of the eLearning study adding a manual instruction for all of them.

As I said some lines above, all these tools and content makers are able to co-operate due to the standards which apply rules to the eLearning tools. Therefore in the document I’m going to talk also about the standards related to the eLearning environment.
2. BACKGROUND

“The development of eLearning is discussed in [9], [12], [13], [19] and [35] and the background information in Chapter 2 is mainly a compilation of the material in these sources.”

2.1 What is eLearning?

ELearning has its historical background in about 30 years of development in computer based training and education. With the growth of the internet this kind of training became much more accepted and the creation of multimedia contents and systems to manage learning activities went on faster.

Additional eLearning is based on a long tradition of teaching and learning experience.

The larger worlds Information Technology and Education and Training influenced the new term eLearning and so eLearning became a subset of both of them.

Nowadays, eLearning refers to the learning that is delivered or enabled via electronic technology. It encompasses learning delivered via a range of technologies such as the internet, television, videotape, and computer-based training. In principle, eLearning is a kind of distance learning. Learning materials can be accessed from the web or intranet via a computer and tutors and learners can communicate with each other using e-mail, chat or discussion forums.

Therefore, it can be used as the main method of delivery of training or as a combined approach with classroom-based training. It can be valuable when used as a part of well-planned and properly supported education and training environment, but eLearning is not a magic bullet that replaces existing pedagogical theories and approaches. Nevertheless, it has almost everything that those theories need to get implemented.

Many learning and technology professionals believe that eLearning will have become state of the art when we will stop referring to it by a separate name and begin considering it as an integral part of a complete learning environment. [13]

B-Learning

It is the abbreviation of Blended Learning, "Combined Training" or "Teaching Mixed.” This is a semi-modality study which includes both eLearning and traditional classroom teaching.

It is beginning to adopt this model for online courses, as it combines the advantages of on-line teaching (virtual classrooms, computer tools, Internet) with the possibility of having a teacher as a supervisor of the courses. [35]
2.2 What is a Learning Object?

Typically, a course consists in a series of modules, sections, exercises, simulations, etc., designed to train the student in a set of skills and knowledge. As such, the course is a unit and the composed of individual courses, books, and other eLearning products is named curriculum.

However, it is feasible to separate the different skills and knowledge in minimum units and observe the course as a sequence of these units. Each of these units can be designed as a Learning Object.

Based on this definition a Learning Object is a minimum training unit that carries out a single purpose and that can be sequenced along with other Learning Objects to shape courses covering broader learning objectives.

Basic features of the Learning Objects

So, is a chapter of a course a Learning Object? ...Not exactly. To fulfill its function in isolation, irrespective of the way in which it was included, a Learning Object must have some basic characteristics.

To be an Object Learning independent should have an appropriate structure, including presentation and objectives, formative content and finally an evaluation and conclusions system.

- Brief

By its own nature, a Learning Object tends to be brief. Taking in consideration the on-line limitations as well as the average of self-study session of a user, a Learning Object should if it’s possible, be designed for an average duration of 15 minutes or less.

- Context independent:

A Learning Object should not require another context that himself. Therefore it can not make reference to other objects or ambiguous references. Thus the Learning Object develops its own context by combination with other Learning Objects.

- Labeling (Metadata):

In order to facilitate their identification and tracing, a Learning Object must be properly defined in their Descriptive tags (metadata). In this way it becomes possible to its management and its automatic contextualization with other Learning Objects with which it shares concepts.
• Interoperable (standard):

Learning Objects should be designed according to a standard allowing its platform independence from LMS or LCMS, to enable it to be charged or released for any platform of any manufacturer. At present, the ADL SCORM and IMS are working on a package system of Learning Objects that guarantee this interoperability.

Advantages of Learning Objects

• Flexibility.

A material designed for use in multiple contexts can be reused more easily than a material that must be redeveloped for each new context. This type of formative material can also be updated, indexed and managed on a simple way.

• Customization.

The design of courseware as Learning objects greatly facilitates the customization of content, allowing the recombination of materials tailored to the training needs of the group in question or even the individual.

• Provides competency-based training.

Since each Learning Object corresponds to a specific learning objective, either knowledge or skill, this approach is more appropriate for the course to complete the training programs based on skills. The identification of each Learning Object with a specific skill, as well as the evaluation of the competency gap of each student would design completely customized training routes.

• Increase the value of the contents.

Reusing content increases its value, both by increasing the potential of its future exploitation by the successive amortization of the cost of development.

As can be seen the effort that goes into the design of courseware in a modular fashion more than offset by its benefits. The Learning Objects are the basis for the development of the objectives of eLearning: maximum customization, fully adapting to the training needs of each student, and training just in time, giving each student the exact precise training content in each time. [19]

2.3 Traditional classroom teaching VS Web based distance learning

There are a number of typical features of distance learning, and clearly differences regarding the traditional classroom teaching:
1. Physical separation between teacher and student.

In distance learning, the teacher is usually physically separated from his students, who usually resort to the teachings of their teachers through printed, audio-visual or computer materials. In general, rarely through physical contact, and mostly we can have students located in different parts of the world.

2. Massive use of resources.

The centers which provide distance learning are the resource centers. If we look at European distance universities, we see how they have always been pioneers in the use of these kinds of resources in their teachings.

The massive use of technical resources in the distance learning, has led to have been overcome difficulties arising from the boundaries of space and time, so students can learn what they want, wherever they want and whenever they want.

3. The student as a centre for independent and flexible training.

While in the classroom the teachers teaching determines the pace of learning because they decide how much of the topics they explain every time, in distance learning the student must know how to manage their time and choose their pace of learning. The distance student is much more independent, and it calls for greater self-discipline on the student attendance. The first thing that a distance learning student has to learn is precisely to learn because their success depends of it.

4. Tutoring.

Unlike between conventional educations, the distance learning, apart from course contents, which are not transmitted by a teacher, generally are distributed in print, audiovisual and telecommunication systems, there is a tutoring work, usually carried out by different people that have developed the course content.

Distance education characterized by a physical separation between teachers and students-not excluding physical encounter points, which prevails two-way asynchronous communication where the Internet is used mainly as a communication way for sharing knowledge, so that the student is the focus of an independent training and flexible, having to manage their own learning, usually with external tutors help.

2.4 Advantages and Drawbacks of using the Web in teaching

2.4.1 Advantages of using the Web in teaching

ELearning is based in a massive use of the Web as a way of communication. Therefore, it is useful to know the advantages and disadvantages of using the Web in distance teaching. These are the main advantages:
• Very easy to use.

Once you have access to the Web, work on it is as simple as clicking the mouse, as it is not aware of any required additional computing.

• Multimedia communication system.

When a student is connected to the Web, he can access all kinds of multimedia documents: not only text also sound and audiovisual information.

• The distance between transmitter and receiver of information is not relevant

When you access a Web page, you don’t have any information about where is located physically the computer we have submitted: it can be located only meters from our own computer, or thousands of kilometers away. This does not happen with ordinary mail or the telephone, where pricing is directly related to the distance: the more distant are the sender and receiver, the higher the price to be paid the geographic barriers has disappeared for information exchange.

• Very low costs for students and for teachers that generate contents.

Internet operates as an international nonprofit cooperative, where each partner takes maintenance costs connecting to the nearest node, costs are reduced for everyone.

• Connection to the Web of the vast majority of research centers and universities.

This is one of the great added values of the Web. Furthermore, we have to think that for distance students, it is precisely one of the most important factors regarding his contents, they can access to the largest library of electronic publications ever dreamed. The Web has become, in the industrialized countries, in a media almost universally as fax or telephone.

2.4.2 Drawbacks of web usage in distance learning

• Disorientation in information access.

The procedure for accessing information on the Web is a hypertext; each Web page can contain numerous links to other sites, which are usually marked with a different color or with an underscore. Hence one of the critical aspects of the Web is that the student can be disoriented, as the only way to surf the Web is going selecting cross-references.

• Potential use for destructive and criminal purposes.

There are still critics on the use of the Internet for not corrects purposes, in some cases, even criminal, like getting users information that can be use for swindle and frauds. Also the teaching can be put down to subjective and wrong information.
• Slow access to the Web.

Due to the excessive growth of the Web, it is clear that in some cases might be inappropriate to talk about information highways because the impression you get sometimes is that these highways are almost always collapsed.

2.5 Advantages of eLearning in the enterprise

The advantages of eLearning in the enterprises can be summarized including the following list:

• Greater flexibility.

ELearning provides greater flexibility in regard to the conventional method of the class in the classroom because it is not necessary to be programmed increasingly logistics involved any other action training in the enterprise.

When a course is offered, employees can receive in any slot, apart from the fact that the employee can set their own pace of learning, according to the time available and the goals it has set.
  • Ease to access.

The fact that the employee can follow any course of eLearning, generally he only needs one terminal with an Internet connection and a browser.

• Reduction of learning time.

According to empirical studies carried this purpose, it was found that the times of learning can be reduced between 40% and 60% with eLearning solutions.

• Retention increasing.

In experimental studies, information uptakes of eLearning processes are retained 25% more than if solutions are used in conventional training.

• Compatibility with activities.

ELearning is compatible with many other activities, almost simultaneously, work, recreation, etc… therefore need only access the computer at any time, on the other hand, stop the training when it is desired.

• Convenience.

The eLearning avoids many trips, is a great comfort for employees to avoid frequent trips to far locations from their workplace, even taking an overnight stay away from home.
• Reduced costs.

ELeaning can be up to 30% cheaper than conventional training in the classroom, where we cannot draw the conclusion that eLearning is completely replace of the conventional training, even if they are very different learning methodologies, usually both are complemented.

• Possibility of immediate course contents updating.

In the eLearning courses is possible to incorporate any change at any time, and the employee can access to the updated information. This is unthinkable in the conventional training.

• Personalized training.

The eLearning courses offer the great advantage of being able to be customized, so every employee who is identified on formation site of the company, he will have displayed any information (course offers, tracking of their progress, etc...) that human resources direction has been scheduled.

• Training process monitoring.

A huge advantage of any eLearning training action is the possibility for the human resources direction tracking of each and every one of the employees, even the smallest detail, in the learning process: number of connection times, date and time, exercises carried out, page views, degree of employee satisfaction with each course.

2.6 ELeaning in an economic point of view

ELeaning will be critical to the success of individuals, organizations, communities and economies in the dawning knowledge economy.

Much touted are the benefits of the internet for the various functions of organizations ranging from procurement to marketing to customer service. However, the digital age has spawned an overwhelming mass of raw information that is frequently difficult to retrieve and to use.

The critical and distinguishing strength of countries, organizations and individuals lies in their intelligence and knowledge in this new economy. Network technology has enabled a proliferation of customized and timely educational tools that optimize investment in human capital: eLearning solutions facilitate the delivery of the right information and skills to the right people at the right time.

The globalization of the economy, shortage of skilled workers, free agent mentality, new flexible work situations (telecommuting, for example) and numerous other factors have created problems not easily solved by traditional education, spurring the initial growth of the eLearning industry.
Companies are addressing these problems using technology-based learning resources targeting the academic, corporate, and consumer spheres with managed, interactive, just in time, current, and user centric education tools. These factors and others set the stage for what we believe are exceptional investment opportunities in the eLearning space. [9]

2.7 ELearning needs analysis

An eLearning needs analysis is very similar to the assessment process you would use for any other form of training delivery. The basic model includes:

- Determining training objectives
- Analyzing the needs and skills of the audience receiving the training by collecting data
- Reviewing the data for trends and consistencies
- Designing a high level course outline for the eLearning curriculum
- Developing training recommendations based on the data collected
- Compiling a project plan and budget for the eLearning curriculum
- Summarizing the needs analysis results and presenting them to management.

The development of online material market offers many jobs opportunities for web designers because are based in the Web: HTML pages, Flash movies, etc… the same kind of content developed for other on-line projects.

The previous knowlogment of the web designer makes it particularly suitable for the development of courses. Although knowledge of the basic principles of usability and accessibility and limitations of the medium are essential to develop on-line material, the development of eLearning courses has peculiarities that make it distinct from other types of online content. [12]
3. METHODS

“The different tools, systems and standards of eLearning are discussed in [5], [8], [11] and [34] and the methods information in Chapter 3 is mainly a compilation of the material in these sources.”

3.1 Tools for creating eLearning content

Tools for offering eLearning make sure that the eLearning you create can be accessed by learners conveniently and efficiently. Tools for offering eLearning provide several functions:

- Making eLearning available over a network.

Sometimes this activity is referred to as publishing a course. As its name suggests, publishing makes the course public.

- Administering your eLearning offerings.

Common tasks include enrolling learners in courses, assigning administrators and instructors to courses, collecting fees, and churning out required reports. Even online courses involve a lot of paperwork. Tools in the Offer column of our tools framework help with this paperwork.

- Controlling and tracking access.

To the courses, lessons, and individual objects you offer. Tools may be needed to restrict access to registered learners and log which modules they have taken and completed. Offering may also require recording scores on individual tests and other graded activities.

Creating eLearning refers to the process of authoring and integrating content. It can take place at each level of content. That is, you can create raw media elements; integrate them into pages, displays, and learning objects; link those to create lessons; aggregate the lessons to create courses; and link courses to create a curriculum.

These are the different kinds of eLearning tools that we can find in the market:

- Course authoring tools.

Expressly designed for creating eLearning, such tools simplify the process of implementing instructional strategies, creating menus and navigation schemes, and authoring pages without extensive technical knowledge.

- Web site authoring tools.
For creating HTML pages and linking them to produce entire Web sites, such sites could be courses or material associated with courses. By including scripting, dynamic display effects, and connections to databases, these tools can create highly animated and interactive eLearning content.

- **Testing and assessment tools**

For creating and conducting assessments, these tools create true-false, multiple-choice, short-answer, text-entry, matching-lists, and other kinds of computer-scored tests. Some track performance and generate reports.

- **Media editing tools**

For creating, editing, and “Web-readying” drawings, icons, photographs, animations, sounds, video, and other media included in eLearning.

- **Conversion tools**

For transform documents, presentations, graphics or other contents to formats that can be used in eLearning and on the Web.

**Picture: How the information is created and accessed [11]**
3.2 ELearning System Tools

The tools in this section tend to be the most expensive and technically complex of the tools and technologies we cover in this thesis. Even so, it is important to understand what they offer.

- **Web servers.**
  
  To deliver Web pages and other media requested by a Web browser.

- **Learning management systems.**
  
  To administer courses and students

- **Learning content management systems.**
  
  To assemble and offer courses made up of reusable content modules.

- **Collaboration tools.**
  
  To enable fluid communication among distributed learners

- **Virtual-school systems.**
  
  To conduct instructor-led learning over the network

- **Media servers.**
  
  To deliver sound, video, and other dynamic media efficiently over the network
3.2.1 Web Servers

Web servers are core technology for eLearning projects. The eLearning courses need some kind of web servers due to their nature internet behaviour.

Those who make eLearning courses will not probably setup the web server, but they cannot escape the limitations of the web servers. LMSs and virtual-school systems may be more sophisticated, but it is the web server that does main work.

![Web Server as core technology for eLearning projects.](image)

3.2.2 LMS

A learning management system (LMS) simplifies the process of administering education and training. It is a complex system used by managers, administrators, instructors, and learners to schedule, register, bill, and track learners through courses and other learning events. It lets learners find and register for courses, launch online courses, monitor their competencies, and measure their progress through a course or program of learning. Finally, it helps administrators manage training programs and compile statistics and reports.

The LMS integrates courses created in content creation tools (Web-based and course authoring tools). It can also integrate courses delivered by a Learning Content Management System (LCMS). In these cases, the LMS find the course and redirects the learner to the LCMS, which actually launches the course and tracks the learner’s progress. The LCMS then reports completions and grades back to the LMS.

An LMS is a Web-based database application that sees the courses that has been accessed or has been completed by the learners. Through an integrated, Web-based interface, an LMS lets
administrators make common tasks, like adding courses, registering learners into courses, launching courses for learners, recording course completions and grades, and generating reports.

3.2.3 LCMS

A learning content management system (LCMS) simplifies the task of creating, managing, and reusing learning content, that are the components of courses.

LCMSs manage learning content by maintaining items of content in a central repository. From this database, designers can organize, assemble, approve, publish, and deliver courses and other learning events.

An LCMS lets authors create, store, and refine learning objects or other units of content. It helps learners locate and take just the learning they need at the moment.
3.2.4 Collaboration tools

Collaboration tools help people work and learn together at a distance. They let participants share their ideas, opinions and doubts. They are essential for collaborative eLearning, e-mentoring, and knowledge management initiatives.

This category covers a wide range of tools, from simple text-based e-mail clients to complex online meeting tools. Supplying a complete collaborative environment may require you to combine several separate tools and technologies.

- Synchronous vs. asynchronous collaboration

Collaboration tools can connect participants synchronously or asynchronously.

Synchronous communications, also called conferencing, occur in real time. That is, all participants have to be online at the same time. Synchronous communication media include chat, application sharing, whiteboards, audio conferencing, and video conferencing.

Asynchronous by the other hand make no necessity for the learners to be together at the same time. Then they don’t need to wait the response, expecting that the other participant will read the message at some point.

With asynchronous communication, the participants can send the message when is more convenient for them, and also can reply more relaxed, having time to think about the received message. Anyway, between online forums and e-mails, the forums are less synchronous due to there is less expectation of a quick reply.

These collaboration tools make possible for participants to have free discussion about all those issues they are learning.

The simplest tool is the email. It makes a simple way to communicate not only between the instructor and the student, but also send multiple messages to many participants about issues like changes.

Talking about a special issue, the forums give the best tool, because all the opinions and information about an issue can be tracked.

![Collaboration tool Schema.](image)

3.2.5 Virtual Schools

Virtual-school systems enable the delivery of instructor-led and facilitated eLearning.

They combine capabilities from learning management, content management and collaboration systems.

Virtual-school systems are different from online meeting tools in several ways. Online meeting tools tend to be a collection of collaboration tools increased for eLearning. They tend to be session oriented.

Virtual school systems are more course and curriculum oriented, even though they can share the capacity to conduct online meetings.

Virtual-school system supplies a package of features needed to assemble administer and conduct eLearning courses.
Virtual-school systems usually combine an extensive database that tracks all aspects of learning with a collection of collaboration tools.

The database lists and tracks connections among classes which are defined in the system as learners enroll in particular courses. Curricula are defined as sequences and dependencies among courses.

Courses are defined in terms of lowerlevel objects, which may include specific media. Courses may also involve tests and meeting events, which may include media, such as presentation slides, and may also involve a mix of collaboration tools such as e-mail, discussion forums, chat sessions, audio conferencing, application sharing, whiteboard sessions, and video conferencing.

3.2.6 Media Servers

Conventional Web servers deliver HTML Web pages on request. Because most Web pages consist of text and simple graphics, this is not too difficult a chore. A moderately powerful Web server can handle hundreds of requests per second. But when the media requested are large audio and video files, a conventional Web server may begin to cough, wheeze, and collapse from the exertion required.

The chores of handling many requests for large media files are best handled by a media server, which specializes in high-bandwidth audio and video.

3.3 Standards in ELearning

To enable student monitor activities on the contents, beyond what the statistics it has been developed several standards or specifications in the field of eLearning: ADL, AICC and IMS are the most extended.
All these standards promote content and platforms interoperability from the different manufacturers. Platform or LMS and content are separated by these two basic ways:

- Packaging specifications.
- Test specifications.

The "packaging" is to label the content so that it can be recognized as such by the LMS and enable its to load on the system. In the case of ADL SCORM and IMS specifications (the most widely used at present) this is done by describing the content in an XML file, where are referenced the resources in this content.

Test specifications relate the way that the content must register the user activity in the auto evaluation test and other activities that the course includes. These specifications are the implementation of an API that connects the content with the LMS. However, there are tools to facilitate the creation of evaluation systems, for example, extensions for the most used applications like Flash.

An even easier alternative is the use of specific authorized tools for eLearning, which provide a complete environment to design the contents and do not require programming; automatically packaging contents created and all the code is generated for the student monitoring activity on the content in any LMS compatible. [34]

These tools facilitate greatly the work for content design and online courses and allow the web designer adapt their skills to this new market without excessive complications.

Producers create individual modules or learning objects which must be integrated into a unified course. Standards that allow the assembly of courses authored in different tools by different producers into packaging standards. These same standards enable a management system to import and organize all the components of the course.

![Picture: How the standards work in eLearning. [11]]
3.3.1 Interoperability and compatibility

The standards allow interoperability and compatibility between eLearning components.

<table>
<thead>
<tr>
<th>Interoperability and Compatibility</th>
<th>- The eLearning platform</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Materials and contents to be incorporate</td>
</tr>
<tr>
<td></td>
<td>- Support and monitoring services</td>
</tr>
<tr>
<td></td>
<td>- Creation and development content tools</td>
</tr>
<tr>
<td></td>
<td>- Human resource management systems</td>
</tr>
<tr>
<td></td>
<td>- Evaluation tools</td>
</tr>
</tbody>
</table>

This compatibility allows the freedom to choose providers content and tools, as well as the acquisition of content and assures us a good investment for the future because it allows integrate different tools and even a complete migration to another platform or system.

The advantages of standardization is that it allows the reuse of courses to other platforms, for example, the migration of all the learning data activity to another system (platform, human resources systems or knowledge management), develop of internal courses for their own platform or extract student activity learning data (assessments, learning routes, profiles, etc…).

Independently of the technology and content providers, the chosen system must allow interaction and integration among the multiple and diverse components that form to facilitate such things as:

- The automatic transfer of data between our learning platform and management system.
- The platform (LMS or LCMS) must be able to manage and endure courses from different backgrounds.
- The platform should enable the storage and data management of the learning activity (learning pathways, activities, evaluations, etc…) for their interpretation.
- The platform will allow the import / export of all management and monitoring data.

3.3.2 Institutions of specifications and standards

The model of the initiative ADL SCORM (Advanced Distributed Learning), which several organizations cooperate involving in standardization (IEEE, AICC, IMS, ADL), offers open specifications, tested and stable, which to base the development of tools (eLearning platforms, creation and analysis) and content, compatible with each other.
The internal specifications are the base on which accredited standardization agencies work to achieve an open specification accepted by all: the standard.

A specification is a technical document that describes the components (part static) and behavior (dynamic part) of a particular system.

These specifications derived, in the coming years, an ISO standard (International Organization for Standardization) to govern the open model of "eLearning" so it’s strategic importance and the compliance of tools and content are part of the advantages and capabilities offered by the open architecture.

In those formative technologies the success depends on its interconnection and integration ability with the adoption of open standards.

### 3.3.2.1 W3C World Wide Web Consortium

The W3C is an association that provides specifications for the Web. Although it is not an accredited organization, its specifications are considered standard done for the industry, such as the specifications HTML, XML or RDF.

The W3C specifications are the basic level of standardization in web technology. For example, specifications emitting in IEEE / ADL / IMS are formalised using XML of the W3C as the language to represent the metadata, content structure or the participant profiles.

### 3.3.2.2 IEEE / LTCS Working and Study Groups

IEEE (Institute of Electrical and Electronic Engineers) is one of the most important government agencies for the establishment of international standards. Through his committee LTSC (Learning Technology Standards Committee), performs development of standardization in new learning technologies.
The objective of the various working groups IEEE LT SC is to develop technical standards, practical recommendations and guidelines for software components, tools and design methods to facilitate the development, dissemination, maintenance and interoperability of computer systems implementations and components for education and learning.

The committee IEEE / LTSC consists of a series of working groups under the following standardization lines of virtual learning systems:

- **General.**
  To normalize the architecture, reference model and general terminology
  - **Oriented to student.**
    Student model, tasks model and student identification
    - **Oriented Content:**
      Exchange of data courses, sequence and modulated courses, packaged content, metadata in educational objects
      - **Restrictions and Protocols:**
        Semantic and exchange restrictions, data exchange protocols, restrictions HTTP.
        - communication between systems:
          CMI proposals, platforms and media profiles, communication agents and company interfaces.

### 3.3.2.3 AICC Aviation Industry CBT Committee

This consortium emerged at the end of the 80's as a result of the problem that materials and learning courses for digital aviation industry become obsolete with each new generation of computers. Since then, they work developing technical specifications for learning through digital technologies.

The objectives of AICC are:

- Assist aviation companies and the rest, to the development and introduction of virtual learning.
- Develop recommendations to support interoperability.
- Promote a forum about the authorship of digital content
AICC has developed standards (AGR, AICC Guide Recommendations) specialized in different domains of virtual learning. The most important is the CMI model (Computer Managed Instruction), which offers a broad proposal for the exchange of learning content, management and monitoring of learning outcomes.

It defines how the learning objects should interact with the platform and which information can manage the course and the platform.

Both ADL as IEEE / LTSC have used this CMI standard, which have added various improvements, as a base for their work patterns.

3.3.2.4 ADL Advanced Distributed Learning Initiative

The ADL initiative (Advanced Distributed Learning), is a program of The United States Department of Defense and the Science and Technology office of the White House to develop, through the ADL Co-Lab, the principles and guidelines of work necessary for the development and implementation efficient, effective and large-scale learning on new Web technologies.

ADL does not develop specifications themselves but integrates and complement the already existing ones (consortia and organizations such as AICC, IMS, IEEE / LTSC). Through his ADL Co-Lab, is a true open forum for cooperative research, development and evaluation of prototype digital learning and creating design and specifications guides.

With the model SCORM (Sharable Content Object Reference Model), ADL is positioned as:

- A reference regarding the definition of educational content on-line.
- A set of technical specifications, to be met by Defense Department suppliers of the USA.
- A bridge between new emerging technologies and commercial applications.
- A document for the future development of the technical aspects of digital eLearning content.

3.3.2.5 The initiative ADL SCORM

ADL SCORM model is a complete selection of the most urgent, critical and advance specifications, in IEEE/LTSC (for example, the interface CMI, which regulates the interaction between courses and platform a native of AICC and in standardization process in IEEE / LTSC or the IMS metadata in standardization process IEEE / LTSC).

ADL SCORM is considered the first operating model and real standardization, applicable in learning platforms and content development. ADL SCORM marks a milestone toward standards, should serve as a base for the utilities and compatible content development, opening in practice the industrial implementation phase and commercial use.
3.3.2.6 IMS

The IMS is an open organization, which involved industry and education, government agencies and development societies, who are working on various proposals and specifications for Web technologies learning, such as the definition of metadata for educational resources, definition of evaluation material, etc…

To promote growth and viability of the virtual learning, IMS has two different objectives:

- Help defining the technical specifications to allow interoperability of applications and on-line learning services.
- Promote the implementation of these specifications in products and services, to ensure the broadcasting of digital learning content. [5]
4. THE ALTERNATIVES

“The different alternatives in eLearning are discussed in [8], [11], [16], [17], [18] and [34] and the alternatives information in Chapter 4 is mainly a compilation of the material in these sources.”

4.1 Technology

More and more technology is being purchased and used by people with little technical training or knowledge, the people who are tasked with buying technology and getting it all working are not just information technologists but instructional designers, training department managers, school administrators, teachers, instructors, and trainers.

At the same time the complexity has increased. Those wishing to deploy eLearning must choose from hundreds of tools in many separate categories, including learning management systems, learning content management systems, authoring tools, and collaboration environments, all of which are evolving at a bewildering rate.

The developers first must understand the technologies that underlie such efforts. They have to be able to combine separate tools to create, offer, and deliver content. Such knowledge can be complex and highly technical. And few projects can be done with just a single tool or technology. To complicate matters, tools and technologies change at a frightening rate. Technologies evolve and mature and new tools are continually being developed. Companies form, merge, and go out of business in the span of a few years.

Technology doesn’t make eLearning. People do. The right starting points for any exploration of technology are the people for whom the technology is needed. [8]

4.2 Choosing a LMS

ELearning = Contents (electronic material) + communication (forums, chat, IM, etc.) + monitoring (registration of the student activity).

To facilitate compliance with this “equation” from the mid-90 were developed eLearning platforms or LMS (Learning Management Systems). There is a tremendous amount of LMS in the market offering management features and distributing courses content, communication tools and utilities for monitoring in a more or less closed environment.

The selection of an LMS is not an easy decision. Although the LMS share many features, his philosophy of use and integration possibilities are varied.

In many cases, open source systems are an attractive option because of its cost and potential. Its basic functions are essentially the same as those of large systems and if it is not needed an advanced functionality for corporate environments; these systems can cover the requirements desired.
The first basic difference regarding the “conventional” content development for the web is obviously the didactic orientation, that is, the contents must adapt to some pedagogical principles or solid instructional design.

Usually the instructional design is not entirely in the hands of the web designer, the author / expert in content is in charge of this function, but the web designer should have a minimum knowledge in instructional design.

And secondly we have basically a technical factor in relation with the third element in the eLearning equation: monitoring. [34]

4.3 Choosing a tool to create ELearning content easily

One of the most important parts of this Thesis is to find an easy solution to allow the teachers the creation of eLearning material in an easy way using the most common tools and formats in internet.

A lot of tools are offered in the market to create eLearning content, so it is difficult to choose one of those. I have based my criteria selecting the tools to work with the most used web format that in my criterion is Flash, and the most used methods to create learning courses that, in my opinion, are Powerpoint and screen-recorders, offering the possibility to add narration, video, image and audio, with the possibility to edit all these components to create a professional eLearning content.

Another important criteria in my selection is that the tool selected can combine the characteristics explained in the chapter 3.1 (tools for creating eLearning object) and the tools have also to support the ELearning standard to have the possibility to be added in a more complex system like an LMS if it is desired.

- **ARTICULATE**

Articulate is a very complete tool to work with PowerPoint slides with the possibility to add all kinds of multimedia and to convert in different formats. Articulate is ideal to create ordinary learning content.

- **TURBODEMO**

Turbodemo is a tool thought to record the screen with a lot of recording possibilities adding multimedia and converting in different formats, Turbodemo is perfect to create demos or computer learning content where is important to record the screen for example to teach how to use a program.
• CAMTASIA STUDIO

Camtasia Studio for me is the star tool because it is a complete tool that offers the possibilities of Articulate and Turbodemo, it is possible to work with Powerpoints and to record the screen adding multiple multimedia options and to converting in a multiple formats.

As one of my objectives is to create Flash format and to work with Powerpoint, I think it is a good idea to know more about that.

4.3.1 What is Flash?

One of the most important advances in design terms in the Web has been the vectoring technology developed by denominated Macromedia Flash.

Flash is the commonly technology used in the Web that allows the creation of vectoring animations. The interest in the use of vectoring graphs that they allow you to carry out animations of little weight and that take just a short time in being loaded by the navigator.

Exits two different kinds of graph:

• The vectoring graphs

An image is represented from lines (or vectors) that have certain properties (color, thickness...). The quality of this type of graphs not depends on the zoom or the type of resolutions with which are watching the graph. No matter how much we approach, the graph not to pixel because the computer draws up automatically the lines for that level of approach.

• Images in bit map.

This type of graphs is similar to a square matrix in which each one of the squares (pixels) shows a certain colour. The Information of these graphs is individually kept for each pixel and is defined by the coordinates and colour of the pixel. This type of graphs is depends on variation of size and resolution, being able successively to lose quality when modifying their dimension.

Flash uses the possibilities that working with vectoring graphs offers, easily redimensionables and changeable by means of functions, intelligent storage of the images and sounds is used in its animations by means of libraries, to optimize the size of the archives that contain the animations.

This optimization of the space that the animations occupy, combined with the possibility at the same time of loading the animation that this one is in the navigator (technical denominated streaming), allows to contribute visual elements that give life to a Web without for it the time of load of the page extends until you limit unbearable by the visitor.

In addition to this aesthetic aspect, Flash introduces the possibility of interacting with the user. For it, Flash invokes a programming language called Action Script. Object-oriented, this language knows clearly influences of the Javascript and allows, among other many things, to manage the filling of forms, to execute different parts from an animation based on events produced by the user, to jump to other pages, etc.
In this way, Macromedia makes our available a thought technology to contribute better design at the same time to our Web that allows us to interact with our visitor. By all means, this is not the only alternative of vectoring design applied to the Web but, without a doubt, one is most popular and more complete about them. [34]

4.3.2 What is Powerpoint?

Powerpoint is a powerful program to create presentations with slides to use them when it must expose in public or for its use in any oral or written type of presentation. With Powerpoint is easy to obtain a results and effects that would be impossible with another type of supports or that cost an enormous work.

4.3.3 What is a Powerpoint presentation?

A presentation is a set of slides and documents that appear to an audience, notes for the orator and a scheme that serves like summary. All is stored in a file. Each page that is created in the space of work on the screen constitutes a slide of the presentation. Each presentation can have a single page or hundreds of them. In each slide we can include texts, tables, graphs, sounds, drawings and predefined images made with PowerPoint or with other applications to create a design with a certain format and appearance.

4.3.4 Main reasons to convert a PowerPoint file into a Flash file

This is a detailed list of the main advantages if we convert a PowerPoint presentation into a Flash file. It does not matter what is the final mission, a presentation based in Flash contributes so much to its success because it makes its content easy to access and distribute.

- Greater Accessibility.

Once converted into Flash, a Powerpoint presentation can be easily seen in any Internet navigator like Internet Explorer, Mozilla, Netscape, Firefox and many others. Since more of a
98% of the navigators have installed a plug-in of Flash, it is not necessary to install any special software.

- Compatibility.

Everyone who has a computer, including Macs, Linux, Solaris, HP, SGI workstations, PDAs (PocketPCs and PalmS), and handheld devices (with an integrated Flash reproducer) can see their Powerpoint presentation in Flash format. There are no limits in terms of devices or computer operating systems.

- Reduced size of File.

A Powerpoint presentation converted to Flash can drastically reduce the size of the file up to a 1/10 of the original size.

- Integration of Sound.

A Flash file can also integrate tracks of audio, including music and voice recordings.

- Screen resolution

Flash files can be reproduced to almost any resolution and/or screen size, what makes this file an ideal vehicle to distribute presentations through a great number of different devices.

- Distribution in Internet

To distribute Powerpoint files through Internet so they can be viewed for other users can be easy to do, but not always the final user has Powerpoint installed in their PC. But if we upload a Flash file in any server, forum or discussion group everybody can see it.

- Streaming

Flash files use technology of continuous flow (streaming), which allows the spectators online to start watching the presentation, without the need to wait until the presentation is completely downloaded before to start running it.

- Basic controls of Interaction

Flash files contain inlaid optional controls that allow the end user to start the reproduction, to stop and to rewind the presentation.

- More Options of Distribution

Flash for many of the previously listed reasons is also the ideal format to distribute Powerpoint presentations in CD-ROMs. It allows multi-platform compatibility and at the same time it provides a light and functional file that can integrate audio and video and can be exhibited in different screens and resolutions.
• Ready For Electronic mail

Still if anyone wants to send a Power point file to somebody by electronic mail, to convert it into a Flash file can be a better option. The file is smaller and does not clog your recipient’s inbox. In addition to this, the flash file allows you to maintain all its transitions, animations and effects, and at the same time one makes sure that the person who receives it will be able to open the file without having to download another program.

• Security

Others can publish Power point files if they have Power point installed in their machine. This is not the case for the Flash files. Nevertheless, they allow you to maintain a greater control of their content if it is necessary.

• Friendly with the Firewall

The contents based on Flash do not have problems to cross firewalls because they are like a standard Web content.

4.4 Manual Instructions
4.4.1 ARTICULATE. [17]

Articulate is a rapid eLearning program with an intuitive technology to train and communicate widely, rapidly and effectively for academic costumers, you can make easy to create a professional Flash presentation, add narration and interactivity in a PowerPoint file and transform it to a Flash presentation easily.

Develop and deliver content fast and distribute it in a Flash format that can be viewed for anyone. You can do it in three simple steps.

- **Step 1: Create your PowerPoint presentation.**

Include animations if desired; type your script directly into the presenter field in association with each slide.

- **Step 2: Add your narration.**

Select *record narration* in the Articulate menu and begin recording, you can record also with animations and later review the audio recorded. You can look at your slide notes at the same time that you are recording them; this can help you to find the best words for your narration.

- **Step 3: Publish for online delivery.**

Select *publish* in the Articulate menu and add the presentation that you want to publish on the Web by adding the publish location and presentation title. By selecting the *player template* from the drop-down menu, you also have the possibility to edit the desired player templates and to select the presenter/s and logo options.

4.4.1.1 How to use Articulate?

When you have successfully installed Articulate in your computer, you can access to the Articulate menu display and see the different options you can work with.
4.4.1.2 Narration and audio

You can add narration to your slides with the Record Narration Window.

Select *Record Narration* from the Articulate Menu and the Record Narration window will be displayed in the lower right-hand corner of the screen.
In the Record Narration Window you have different options of recording, click on the **Record** button to start recording, and use **Pause** to take breaks during the recording. When you have finished, click **Stop** and to continue click again on the same button.

To move forward to the next slide click **Next** and to finish click **Close**.

If the slides contain animations, you will be taken to the Next Animation once you have finished recording by clicking again on the **Record** button. Automatic animations will respect the timings set within the *Custom Animation* dialog of PowerPoint.

Using **Options** you can record only one slide, show slides notes or display the total duration of the presentation below the slide counter.
4.4.1.3 Import Audio

In addition to recording your own narration, you can also add narration to your presentation by importing audio files. This may be necessary when you want to add audio that was previously recorded.

Select *Import Audio* from the Articulate Menu and the Import Audio window will be displayed.

To import audio, select the audio file that you want to import by browsing; you can only import one audio file per slide; so you have to repeat this for all the slides you want to import audio and click *Done* when you have finished. You can also remove the narrations or imported files that you desire.
4.4.1.4 Sync Animation Timings

If you wish to edit the timings of your animations, you can do it either with the Timeline Audio Editor or with the Edit Animation Timings Window. This is useful if you are satisfied with the audio, but you would like to make adjustments to the timeline when the animations are being displayed.

Select Sync Animation Timings from the Articulate Menu and the Sync Animation Timing window will be displayed.
Click *Start Sync* to play the audio and *Next Animation* to see the next animation. Repeat this for all animations on that slide and use *Options* to see the slide notes or the total audio duration.

**4.4.1.5 Timeline Audio Editor**

You have precise control over your recorded or imported narration, allowing you to edit the audio track for each slide, as well as drag-and-drop markers for synchronizing your narration with your animation. You can also import, cut, paste, and delete narration.

Select *Timeline Audio Editor* from the Articulate Menu.
Details about the audio on each slide are shown at the bottom of the Timeline Audio Editor and you can use its different options to listen, synchronize and review the narrations or imported audio files of your presentation. With this option you can also create new narrations, import audio files or icons, and remove them if you desire.
You can also edit the volume, increase or decrease it with the volume controller, fit the balance of your records and have a view of your recordings by using the zoom.

Another possibility to adjust balance and volume is the *Recording Source & Volume* with which you can record a new narration.

4.4.1.6 Library and options

Articulate includes an option to set up presenters, logos, playlist and quality among other settings.

Select *Library and Options* from the Articulate Menu
4.4.1.6.1 Logos

Select the *logos* option to add, delete your logos or to create a new default logo.
4.4.1.6.2 Presenters

Select the presenters option to add, delete or edit a default presenter to the presenters library. Edit the name, email, biography and photo of the presenter and the title of the presentation.

You can add a new presenter when you publish a presentation or to assign a different presenter to each slide of your presentation using the Slide Properties Manager.

4.4.1.6.3 Playlists

You can create a new playlist, rename, delete, add, remove, move the tracks up/down; put it on the top/bottom. If the playlist duration is less than the duration of the slides you can also loop the playlist.

Regulate the Volume level related to narration from the selected playlist to any audio. You can also add records to the playlist using Record Narration or to import it by using the Import Audio option.
4.4.1.6.4 Quality

You can optimize the quality of presentations that will be delivered on a web server via internet or intranet, optimize for CD-ROM delivery or customize for users with an advanced knowledge on compression settings.
4.4.1.6.5 Other

Set the *Timing* for slides that contain animations, *SWF options* to configure Flash options and *General* for other specific options.
4.4.1.7 Slide Properties Manager

Select Slide Properties Manager from the Articulate Menu

The presentation or eLearning course title appears in the upper left-hand corner of the Slide Properties Manager; this title is taken from your file name. The total number of slides and the total duration of your presentation or eLearning course are displayed in the upper right-hand corner.

Details on other elements of the Slide Properties Manager are outlined below:

- **Type**: The icon in the Type column represents the type of content of the slides.
- **PowerPoint Slide Title**: This is the title of your PowerPoint slide.
- **Display in navigation**: This is the title of the slide you would like to appear in the Articulate Player Navigation.
- **Level**: The hierarchical or nested level of the slide relative to others.
- **Change view to**: Use this field to automatically change the view of your presentation or eLearning course on a per-slide basis.
- **Presenter**: This is the presenter you would like to associate with the selected slide.
- **Audio Playlist**: This is the playlist you would like to associate with the selected slide.
- **Move to next slide**: Use this setting to determine whether the slides should advance automatically to the next one during the presentation, or whether the user will need to click Next to advance.
- **Group by**: Select how to sort the Slide Properties Manager.
You can group the slides by slide number, type, presenter, change view to, audio playlist or move to the next slide.
4.4.1.8 Quizzes and Learning Games

Note: To create a new quizz you need to have installed Articulate Quizmaker.

You can incorporate your quizzes created with Articulate Quizmaker directly into the Articulate Presenter. To create a new quiz you have to install Articulate Quizmaker in your computer.

Select Quizzes and Learning Games from the Articulate Menu

To insert your .AQP file into the Articulate Presenter, select Insert published Quizmaker Quiz.
Browse to locate an .AQP file and the quiz will be added when you publish your presentation.

If the user passes the quiz you can choose different ways to continue such as closing the window, moving to a URL or to a specific slide.
Specify if it is obligatory that the user completes the quiz to continue or if it is possible to view the slides at any time, after attempting the quiz or after passing the quiz.

To edit your Articulate Quizmaker Quiz select Edit settings for inserted Quizmaker quiz; for which previously you should have included a quiz.
To add a Learning Game.

Select *Quizzes and Learning Games* from the Articulate Menu

A learning game can be used for knowledge checks and make your presentation engaging and interactive. You can add a new learning game or edit an existing learning game slide.

With articulate presenter we can create three types of games:

- *Choices*: Multiple choice and True/False questions.
- *Word quiz*: The user objective is to reveal the hidden answer before running out of time.
- *Sequence*: The user objective is to arrange items in the correct sequence before running out of time.

You also have the possibility to display the standard instructions of the learning game and to display a customized message before the learning game.
Enter the questions and answers for the different games and the type of interaction that you select for them.

You can also modify the feedback text that will appear when the user will finish the game.
Finally, click *finish* to insert the Learning Game into the presentation. You can *copy* and *paste* your learning Game slide into any other eLearning course or presentation.

### 4.4.1.9 Engage Interactions

**Note:** To use this option you have to be installed Articulate Engage

You can add your interactions created with *Articulate Engage* directly into *Articulate Presenter*.

Select *Articulate Engage Interactions* from the Articulate Menu.
• **Interactions Slides:**
Your interaction will be inserted as an entire slide within your eLearning course or presentation. Use this option if you want to make your interaction, such as a process or timeline.

• **Interaction Tabs:**
Your interaction will be inserted into a specified slide as drop-down reference content within the slide so users can reference the interactive content at any point within the course. This is perfect for interactive FAQs and glossaries that you want to be accessible throughout the eLearning course or presentation.

### 4.4.1.10 To add a Flash Movie
Select *Insert Flash Movie* from the Articulate Menu and the Flash Movie wizard will be displayed.
The Flash Movie Wizard will appear to insert a Flash movie; you can display the Flash Movies in three different modes:

- **Display in slide**: This will display your Flash movie (.SWF format) in the slide panel.
- **Display in presenter panel**: This will display your Flash movie (.SWF or .FLV format) in the presenter panel of your presentation.
- **Display in new browser window**: This will open a new window independently from your slide within your Flash movie (.SWF format).
In this window you have to enter the location (path) to your Flash movie.

![Insert Flash Movie dialog box](image)

4.4.1.10.1 Configuring Flash Movie to display in Slide

Select the appropriate Synchronization for your Flash movie.

- **Play Flash movie and slide in sync:**

Select this item for Flash movies that have defined beginning and end points such as videos, screen recordings and many simulations. This item will automatically set the slide length to match the length of the Flash movie. You will also be able to play/pause and seek within the Flash movie using the Articulate Player controls.

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click the next button to move on. Set a buffer duration (in seconds) before the movie begins to play.
• **Play Flash movie after slide has begun:**

Select this item for highly interactive Flash movies that do not have a clearly defined end point such as interactive “click and explore” movies.

Choose when the Flash movie will start being displayed on the screen. By default, the movie will display immediately but you can change these settings with *The Articulate Player controls*.

You can also choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the *next* button.
4.4.1.10.2 Configuring Flash Movie to display in presenter panel

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the next button.
4.4.1.10.3 Configuring Flash Movie to display in new browser window

Determine the dimensions of the browser window in which your Flash movie will appear. Select full screen, predetermined size or customize the size for your browser window. Set a buffer duration (in seconds) before the movie begins to play.

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the next button.

Finally, click finish to insert your flash movie into the presentation.

A small icon will be inserted on the bottom right-hand corner of the slide. You can position this icon anywhere on the slide. The icon is for your reference only to indicate that a Flash movie has been inserted but it will not appear when the presentation is published. You will be able to view your Flash movie when your presentation is published.
4.4.1.11 Inserting Web Objects

Web Objects can be used for inserting existing Web pages into your presentation. You can integrate your company’s intranet, or incorporate a Web page that contains video, animation, assessments, or any other content relevant to your presentation. You can also insert an entire pre-existing Web site into your presentation.

Select Insert Web Object from the Articulate Menu and the Web Object Wizard will be displayed.

Web Objects can be displayed in two different ways:

- **In Articulate Player**: This will insert your Web Object directly in your slide.

- **In a New Browser Window**: A new browser window will be opened independently from your slide.

You have to enter the address (URL) of your Web Object. If the Web site is in your computer, you have to select the folder and make sure that contains an index.htm or an index.html file.
Determine the dimensions of the browser window in which your Web Object will appear. Select full screen, predetermined size or customize the size for your browser window. Set a buffer duration (in seconds) before the Web Object begins to play.

Choose whether the slide will automatically advance to the next slide when the Web Object finishes, or if the user must click on the next button.
• **Settings in New Browser Window**

These settings are useful in limiting what actions a user can perform within the Web Object. The default is to allow the user to resize the window and to scroll around. The user can view the entire content of the Web Object, while restricting the user’s ability to surf other Web pages that may not be relevant to the presentation. The browser window settings from which you can choose are identical to those found in Internet Explorer.

You can only insert a Web Object per slide and it can be viewed after you have published your presentation.

Popup blocking software can cause problems when viewing presentations that contain Web objects configured to appear in a new browser window. If using popup blocking software, it is recommended that the domain from which the presentation is being launched be added as a safe domain so no functionality is lost.
Finally, click *finish* to insert your web object into the presentation.

### 4.4.1.12 Attachment

Select *Attachments* from the Articulate Menu and the dialogue box will be displayed.

For each attachment you have to insert the title, type and path.
4.4.1.13 Player Template Builder

Almost every element of the Articulate Player can be customized. With so many customization options, it is useful to have a way to save and quickly apply pre-configured player options. This can be done with the Player Template Builder.

The Player Template Builder is a simple tool for creating and editing Templates (pre-configured player options) that customize the Articulate Player in a quickly and convenient way.

Select Player Template Builder from the Articulate Menu and the Player Templates Builder will be displayed.
Master Templates

Articulate Presenter comes with four pre-configured Master Templates:

- Corporate Communications
- ELearning Course (Single-level)
- ELearning Course (Multi-level)
- Tradeshow Loop

You can create, save or delete templates in the drop-down menu and preview the different configurations done.

4.4.1.13.1 Layout

**View mode**: Select the format in which the slides will appear to the viewer. You can choose among standard view, no sidebar view (sidebar is not visible), or slide only view (the only item visible is the PowerPoint slide). You can also set a starting view for Articulate Player.

**Panel**: Display/hide logo panel, presenter panel and navigation panel.

**Navigation Tabs**: Display/Hide outline, thumbnails, notes and search tab and set order of tabs using up/down arrow. You can also set a starting tab for Articulate Player.

**Toolbar menu**: Display/Hide the tabs to access the attachments, to allow bookmarks, email your presentation and/or exit link.

**Player Controls**: Display/Hide the volume, navigation and seekbar controls. Decide also whether or not users can navigate using the seekbar.

**Slide Titles**: Edit timing for long slide titles and display/hide the slide number.
4.4.1.13.2 Navigation

Use the Navigation section of the Player Template Builder to configure options for user navigation within the Articulate Player.

**Navigation Restrictions:** Select if user can view slides in any order, view only current and previous slides or cannot change slides.

**Level Expansion Settings:** Select expand behaviour and expand restrictions to allow user access to the slides at different levels.

**Miscellaneous:** Select other settings such as prompt to resume on presentation restart, automatically scroll navigation to keep up with presentation or enable keyboard shortcuts.
4.4.1.13.3 Text Labels

Use the *Text Labels* option of the *Player Template Builder* to custom the text for every element of the Articulate Player you want to display.

4.4.1.13.4 Colours

Use the *Colours* section of the *Player Template Builder* to modify the colour of a particular
Edit Color Schemes: Select this option to load the Colorizer that will allow you to customize the color of your Player by choosing from a set of some predefined color schemes or creating your own color schemes.

4.4.1.13.5 Other

Use the Other section of the Player Template Builder to configure additional player template options.

Other: Select other settings such as whether the duration of the presentation should be
displayed; if the presentation should automatically start over from the beginning after the last slide is completed; if the presenter notes should appear when launching, as a tab on the lower right-hand corner or remain hidden.

**Browser Window Settings**: Select the desired browser and presentation size and select if you want to launch the presentation in a new window via launch page. When selecting launch page in a new window you can decide if displaying browser controls and if the user can resize the browser containing.

Select **Preview** to launch the Articulate Player and pre-visualize the options that you previously customized with the Player Template Builder before creating your presentation.

4.4.1.14 **To publish your presentation**

Select **Publish** from the Articulate Menu and the Publish Window will be displayed.
4.4.1.14.1 Publishing for Web delivery

Select this option if you want your presentation to be published locally or if you are going to upload it onto a Web server on the Internet or an Intranet. Also select this option if you want to FTP your published presentation directly to a server.

Publish Location: Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

Properties: Determine the title of your presentation and choose a player template, logo and presenter.

Output Options: Check the zip box to compress your presentation into a zip package and check the Email box to attach the zip file to a new email.
4.4.1.14.2 Publish to Articulate Online

Publish content directly into your Articulate Online Account.

**Note:** You need to install Articulate Online.

**Properties:** Determine the title of your presentation and the description that will appear along with the presentation in your articulate online account. Choose a player template, logo and presenter if desired. Select how your course’s status will be tracked and deemed with *Reporting* and *Tracking* options.

**Account Information:** You must already have an articulate online account. Insert the account URL, the administrator e-mail address/login and password.
**Reporting:** Select the reporting status Passed/Incomplete, Passed/Failed, Completed/Incomplete and Completed/Failed.

**Tracking:** Select if the user must view a set of slides or successfully completed a Quiz / choices Learning Game before completing the course.

Once you have published your presentation, Articulate Presenter will automatically upload your eLearning course or presentation to your account in Articulate Online.

When the upload has been completed, you will have the option to launch your Web browser to view or manage the content of your presentation in your Articulate Online account.
4.4.1.14.3 Publish for LMS

Select this option if you plan to upload your presentation or eLearning course to a SCORM- or AICC-compliant Learning Management System.

**Publish Location:** Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

**Properties:** Determine the title of your presentation and choose a player template, logo, presenter and the communication standard supported by LMS.

**Output Options:** Check the zip box to compress your presentation into a zip package and check the Email box to send the file by email. Select both options if you want to send the zipped file by Email.

**Reporting:** Fill in the *LMS Course Information* Title and Identifier fields. Select also the *LMS Reporting* status from the drop-down list. For AICC standards you also have to incluye the Filename (URL) which must be set in advance to the URL of the server from which you will be serving your presentation.
Tracking: Select if the user must view a set of slides or successfully completed a Quiz / choices Learning Game before completing the course.

4.4.1.14.4 Publish for CD

Select this option if you will be distributing your presentation via CD-ROM.

Publish Location: Type the path to the folder/network where you want to publish your presentation.
**Properties:** Determine the title of your presentation and choose a player template, logo and presenter.

**Output Options:** Check the *zip box* to compress your presentation into a zip package and check *create autorun files* box to play automatically your presentation when stored in a CD.

![Publish to CD](image)

**4.4.1.14.5 Publish to Word**

Select this option to convert your presentation to Microsoft Word format as a Storyboard or Presenter Notes.

**Publish Location:** Type the path to the folder/network where you want to publish your presentation.

**Properties:** Determine the title of your presentation, the presenter and choose and select the output type depending on how much information you require. *Storyboard* include information of presentation data, presenter data, slide data, slide thumbnails, slide notes, interactions questions and answers, web object information and inserted flash movie information. *Presenter Notes* exports the presenter notes only.

**Output Options:** Check the *zip box* to compress your presentation into a zip package and check the *Email* box to send the file by email. Select both options if you want to send the zipped file by Email.
4.4.1.14.6 Publish to Project Files

Select this option to publish and archive your source files (PowerPoint file, associated, audio, images, etc.).

**Publish Location:** Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

**Properties:** Determine the title of your presentation

**Output Options:** The published presentation will be created as a Zip package by default. To send the zipped presentation, check the *Email* box. If you would like to include your source (uncompressed) audio files in your project files, check the *Include .WAV files* box.
4.4.1.15 View Presentation

Select this option if you want to preview your presentation in Articulate Player.

Select View Presentation from the Articulate Menu.

If you have not yet published your presentation, the following message will appear:
If your presentation has been previously published, you will receive the following message:

![Articulate Presenter](image)

You can also view your presentation at any time by navigating to the output location and doubleclicking `player.html` or `launcher.html`.
4.4.2 TURBODEMO [16]

TurboDemo is a capture Screenshots program which allow reproducing actions such as the movement of a mouse cursor and to record audio at the same time that you are capturing using different effects. The video obtained can be compiled in different formats and published by different ways compatible with all current Internet formats.

Turbodemo is easy to use for capturing the activity in your screen and creates interactive demos and tutorials, software simulations and films in few minutes in the following formats:

- Flash demos/tutorials
- Java/HTML demos/tutorials
- Executable files
- EXE - Standalone Player
- GIF files
- Microsoft Word export
- PDF documents
- AVI files and
- ASF - Windows Media Player format
- Export to Word, Excel, etc.

To create a demo or tutorial you only need to follow three simple steps:

1. Capturing: screen shots of a software application or any onscreen activity.
2. Editing: adding animation, text, voice-over and interactive features.
3. Publishing: generating a finished file for the Web or CD.

The main reasons to use TurboDemo are:

- Easy to use.

  Create your demo in few minutes with a user-friendly interface.

- Extremely small file size.

  The generated demos are optimized and compressed to enable rapid loading.
• No Plug-Ins required.

The viewer does not have to download a plug-in in order to view the demonstration. The generated Demos are independent of the Operating System (Windows, MAC, UNIX…) used.

• Interaction with the viewer.

Add descriptions, notes, objects and actions to personalize your Demo or Tutorial.

**Menu items**

• *File menu* is used to close and save projects and demonstrations.
• *Edit menu* is used to copy, paste, cut or delete objects.
• *Slide menu* is used to add objects to the current slide; multiple objects can be gathered in a group to enhance.
• *Project menu* is used to add slides to your project after it has been captured and stored.

**4.4.2.1 Capturing**

Select *New Project* from the *File menu*.

The first step is to specify the windows size to start capturing. You can do this manually or using a pretested size. You can also change *Hot-Keys* to capture (predefined keys to execute an option).
The next step is to select the screenshot capture options by checking the different predetermined options that you want to use in your project.

There are several ways to capture or record a screenshot; using the right- or left-click of your mouse or using a hotkey. Additionally, TurboDemo may be set to automatically capture at the rate of an adjustable amount of screenshots per second. By using a hotkey you can toggle between screenshot mode and thumbnail mode to monitor the screenshots you have taken.
Choose the appropriate resolution for capturing; TurboDemo will show you a rectangle of this size on the screen. You can also adjust the size of the rectangle by clicking on the dots on the red frame and moving them.
Adjust the red frame to the application that you want to capture, fit easily your application into this red rectangle by using the hot-keys CTRL+SHIFT+P or CTRL+SHIFT+R; with each click of your mouse in the red rectangle area TurboDemo will capture the current screen. Alternatively you can define a key to do this by default is the Pause Key.

When finished capturing, you can return by clicking on the TurboDemo icon in the System Tray. When this icon is hidden from view, press the Print Key to finish capturing.

After finish capturing you can edit, generate or publish your Demo/Tutorial.

• Automatic Capture Screenshots

You can capture screenshots automatically at preset time intervals. This automatic interval can be toggled with the key sequence CTRL+SHIFT+T.

• Capture Screen and Audio

To capture screenshots and audio at the same time, you should choose the appropriate option in the Screenshot Wizard before you start the capture session. The audio gets cut when you capture a screenshot, which means that you need to record the audio first and then take your screenshot, in order to avoid hops in the audio playback.
4.4.2.2 Editing

When you are done capturing screenshots, you will start in Thumbnail mode, where you can see your slides, add, move and remove them. Selecting one slide you switch to single slide mode where you can add text, animated objects, photos, images, interactivity, links to the web, and sound.

4.4.2.2.1 Thumbnail Mode / Slide View Mode

Thumbnail mode is the main view of Turbodemo, which provides an instant overview of your project and appears immediately after you finish the screenshot session.

In this mode you can cut, paste, copy and delete slides, insert slide actions and add sound. You can also easily open other projects and copy slides from them to your current project.

The main options you can access quickly from the Thumbnail view are the following:

View: Select a slide to switch to Single Slide Mode or play a demo of your slide to have a preview of your project.

Slide Tasks: Here you have the principal tasks to work with the slides, insert sound, effects and colours to your slides.

Export Slides as: Select a format to export your project.
4.4.2.2.1.1 Project Options

Select *Options* from the Project menu and configure the settings of your project.

**Timing:**

- **Minimum reading time:** Set the shortest time a slide is shown. This option is useful if you want to capture screenshots automatically.
- **Character reading time:** Set the time that is added to a slide when notes or bubbles are added.
- **Mouse pointer speed:** Adjust the speed of the mouse pointer movement.

**Miscellaneous:**

- **Animation:** choose if notes and balloons will be animated or not.
- **Show action description of object:** select if the assigned object actions will be displayed in the slides.

**Subject:**

- **Title & Comment:** give a title to your project and add a comment to it.
4.4.2.2.1.2 Insert Sound

Add sound or tone with voice and background music. Select Insert Sound from the Slides Tasks panel or by clicking the speaker icon on the slide.

To start recording press the red button and to stop recording press the square black button.

Audio can also be imported. Navigate in the sound recorded, export audio to a .WAV file or delete it. If you add sound or narration to the slide you can choose add sound to only one slide or to several slides.
Change and edit your recorded or inserted audio, adding silence, comments and adjust volume with the *audio editor*. To access the *audio editor* select the *Advanced Mode* option.

4.4.2.2.1.3 Add an image

Add your company logo or a simple image.

Select *Add Image(s) as a Screenshot* or *Insert Image(s) as a Screenshot* from the *Project* menu.
By inserting images the selected picture will be positioned between the other slides but if you add it will be moved directly after the last slide.

You can also add or insert new Screenshots images and Blank Slides to your current project and change the slide color if desired by selecting the appropriate option from the Slides Tasks panel.

4.4.2.2.1.4 Slide Transitions

Assign transitions to the slide selecting Slide Effects from the Slide Tasks panel. Choose a predetermined effect and the colour for when each slide appears and dissapears. You can also preview your selected effect.
4.4.2.2.1.5 Adding Objects and actions to a slide

This is also a type of interactivity option that allows the user to create customized areas or regions and assign them to an action which gives the ability for the end-user to jump and move from one slide to another in the project or going to an URL.
4.4.2.2 Single Slide Mode

To edit slides **double-click** on any slide in the **thumbnail view**

Navigate to other slides by clicking the top bar arrows on the **Player Controls**.

The main options you can access quickly from the **Single Slide Mode** view are the following:

**View**: Select this option to return to **thumbnail view**.

**Add to Slide**: Here you have the principal interaction objects you can add to each slide such as notes, balloons, rollovers, quizzes…

**Slide Tasks**: Here you have the principal tasks to work with the slides, insert sound, effects and colours to your slides.

**Player controls**: select this option to navigate to other slides and to play the selected slide.
4.4.2.2.2.1 Description Notes

Add text objects via Text Notes, Balloons, Text Objects and Rollovers selecting from the Add to Slide menu.
To edit the text object double-click on the object square. Select the font and style in the text box and the appearance of the object selecting the appropriate skin settings.

4.4.2.2.2 Animations

Add animations as pointers, elastic bands, Shockwave Flash files and typing simulation to draw the attention of the viewer to a particular part of your presentation. Select these options from the Add to Slide menu.
4.4.2.2.2.3 Interactive functions

Add interactive functions as click area, text area, pause button and quizzes. For the click area and the text area a message of succes or error will be displayed depending on the user’s actions. With the pause button the user can stop in the selected slide. Select these options from the Add to Slide menu.

You can only add one interactive function per slide.
4.4.2.2.4 Question and Answer (Quiz)

The question and answer quiz is very suitable for the creation of multiple choice tasks for your eLearning demonstrations. You may write down your questions directly or use preset questions in the form of images.

You can decide whether only one answer is correct or whether several correct answers are possible.

Depending on the answer the success or error message will be displayed. To the success message and the error message can be assigned an action option. This means that after showing the message an action or event will occur.

The quiz object can have multiple individual error messages.
4.4.2.3 Publishing

Publishing or playing a demo.

Select *Generate Demo / Publish Demo* from the File menu and select the appropriate format for your Demo or Tutorial:
The first step to publish in all the formats is to select a folder where will be saved all the files that Turbodemo will generate.

### 4.4.2.3.1 Generate a FLASH (SWF), EXE (Standalone) or JAVA (Applet)

- **Settings**

Select the color mode, tutorial title, miscellaneous options, output language, version information and choose between the following Navigation Panels and Skins for Flash and Exe formats:

**No Control Panel**: Run your Tutorial without using a navigation panel or menu.

**Navigation Panel**: A navigation control panel will be added to the bottom of your Tutorial including play control buttons.

**Hidden Panel**: A hidden panel is displayed on the top right hand corner of your Tutorial. The navigation panel is hidden as menu and is automatically shown when the end-user indicates it with the mouse.

- **Statistics**

You can generate demonstrations or learning software that can be included into Learning Management Systems in SCORM standard. These Demo or Tutorial files can also be compressed automatically to one single file, if the LMS requires it.

Select if you want the statistics to be shown at the end of the demo and the pass conditions that will allow the user to access the next level.
4.4.2.3.2 GIF-Animation and Windows Media Player (ASF)

Select if you want to export your Tutorial with slides transitions and / or export sound in ASF format.
4.4.2.3.3 Word Document

Select the appearance of your final word document and the slides and objects that you want to export. You can also import a template, introduction and conclusion from another word file.

4.4.2.3.4 PDF Document

Select the appearance of your final PDF document and preview it before exporting.
4.4.2.3.5 Images (BMP, GIF, JPEG)

Select the image format for your slides, their size and which of the slides and objects you want to export.
4.4.2.3.6 Resize the Project

After you have completed a Demo or Tutorial you can alter the resolution size of your project.

Select *Resize* in File menu and the Wizard Dialog will be displayed, the original width and height is displayed at 100%. After finish resizing, a new project with the resolution size selected will be saved automatically.

If you wish to put your Demo or Tutorial on your homepage then you have to upload the Demo or Tutorial files to your web-server. If you wish to put your Demo or Tutorial on a CD-ROM or other media, you have to copy the files into a directory or folder.
4.4.3 CAMTASIA STUDIO [18]

Camtasia Studio is a program to create demo, presentation and compelling training and to share it with anyone.

Camtasia Studio allows you to:

- **Produce Web Site Content**: Create a video of an application and publish it on the Web with Flash.
- **Training, Education, and Distance Learning**: Capture, share and manage knowledge. Make and share how-to videos.
- **Help Desk, Online Help, Help Systems**: Handle error recording and reporting.
- **Desktop Monitoring**: Monitor desktop activities, process control and live content.
- **Documentation**: Preserve and archive desktop activities.
- **Conferencing**: Record, share and archive conference content.
- **CAD and Simulation**: Record and share animation, CAD designs, and annotation.

In addition to this, with Camtasia Studio you can also choose different file formats to produce them all at once, preview feature comparing the results of different formats and compression settings, publish your videos where others can easily view its content, and even to add iPod files to the production list.

Furthermore, you can edit out background noise, remove volume variations and choose a variety of playback bars and Flash pre-loaders to improve the quality of your video.

These are the main reasons that make Camtasia Studio faster and easier:

- Quizzes and Surveys are easier to create and more professional in appearance.
- An **Audio Volume Indicator** and an **Audio Setup Wizard** make it easier to choose the best audio settings for your needs.
- Edit Presets or create new ones to use repeatedly or to share with others.
- PowerPoint recordings created with **Camtasia Studio Screen Recorder** are processed almost instantaneously.
- Extend any frame of a previously recorded video and add narration or conclude remarks.
- Resize automatically your callouts to fit your text.
4.4.3.1 Welcome dialog

The first time you work with Camtasia, a welcome dialog box is displayed to choose the option with which you want to start working.

- Record the Screen with the Recording Wizard

Select Start a new project by recording the screen in the welcome wizard dialog.

Select the area that you want to record choosing a region of the screen or a window defining a specific area to record using the mouse or introducing the coordinates manually; or select recording the entire screen.
• Recording Options

Select the source/s that you want to include in your screen recording. Select to add camera video or narration depending on your needs.

4.4.3.1.1 Audio Settings

Select **Record Audio** and the *Audio Settings* dialog will be displayed.

Choose the audio input source for your recording by selecting microphone, speaker audio, both or another manual input selection and adjust the input level with the slide.
For advanced users, specify audio format and attributes with **advanced audio settings**.

- **Tune Volume Input Levels**

  Adjust volume manually or automatically to the best level for the selected input source.
4.4.3.1.2 Camera Settings

Select **Record Camera** and the *Camera Settings* dialog will be displayed.

The correct camera device should be selected by default, but otherwise you can select it from
the menu and a preview will appear to show you that the camera is working correctly.

You can change *camera properties* to define the configuration of your camera (brightness, contrast, hust...) and change the *video format* that will be supported by your camera.
4.4.3.1.3 Recording

- Begin Recording

The recording wizard will appear after defining the previous mentioned settings.

Click the **recording button** or press **F9** to start recording, and click the **stop button** or **F10** to stop recording.
• After recording

When you finish recording, audio and video will be compressed in the appropriate format.

A preview of the recording will be displayed where you can watch your recorded video and to save or delete it.
• Save the recording

Give a name and a location to the video recorded and the Post-Save Options dialog box will be displayed.

You can choose to edit the recording on the Timeline, select a shareable format to distribute the video or to record another video.
4.4.3.1.4 Working with Powerpoint

A new tool bar will appear on the left hand side of the PowerPoint screen with the different options to record the screen, as adding narration and/or webcam video.

Press **F9** to start recording and the presentation will be launched and **F10** to stop recording. You can record slide per slide or record the whole presentation at once.

- **PowerPoint Options**

Select the *Option box* from the recording bar and the Option dialog will appear.

Choose the different options to record adjusting the audio and webcam settings making possible to include different codecs of audio and video. Configure the recording hotkeys and select the appropriate program options for your recording.
You can include a watermark; this is a way to stamp ownership on the intellectual property. Determine the most suitable settings for your watermark selecting your image and adapting it to your video adding effects, scaling the image and selecting the better position to locate it.
4.4.3.2 TimeLine View or Main View

In the principal view of Camtasia Studio you can find:

* **Task List:** You can record on the screen or PowerPoint, add new clip to your project, edit your recorded videos and produce your project in different formats.

* **Clip Bin:** Here your media files are stored to easily access, you can preview your clips in the **preview area** and add them to the **timeline**.

* **Preview Area:** Here you can preview a selected file from the **clip bin** or the **timeline**.

* **Timeline Toolbar:** Use it to edit and configure your clips, adding transitions, splitting the video, making cuts and adding audio tracks.

* **Timeline:** Media files are placed on the Timeline to include in the video.
4.4.3.2.1 TimeLine

This is the principal view for editing work where you can assemble video recordings, images and audios. Add, remove, edit and see the timing of each clip and add special effects and enhancements to them.

Each element that is added to the Timeline has its own specific look or color coded icon.

The most important functions you can do in the Timeline are:

- **Search the Video**: Look for specific frames of a video.
- **Lock and Unlock a Track**: When editing a part of the timeline, you can lock a specific track so it remains unchanged.
- **Select**: Make a selection of the area that you want to edit.
- **Cut**: Delete unwanted parts of the clips.
- **Split**: Divide one clip into two smaller clips making it easier to insert images between scenes.
• **Add a Marker:** Markers provide easy navigation points for your viewer as interactive hyperlinks.

• **Drag a Clip or Element to a New Location:** Moves the clip or element to a new location on the same track.

• **Remove a Clip:** Takes the clip out of the Timeline.

• **Delete an Element:** Deletes permanently an element from the Timeline.

• **Extend the Frame of a Video Clip:** Extends the time that one frame is displayed.

• **Mark-In or Mark-Out a Clip or Element:** Marking a clip in or out will remove time from either the beginning or the end of the clip.

• **Adjust the Clip Speed of a Video Clip:** Speeds up or slows down the playback time for an entire clip.

• **Save the Current Frame as an Image:** Saves the current frame displayed in the Preview Window as a BMP, GIF, JPEG, or PNG file.

4.4.3.2.2 Storyboard

With the storyboard you can preview the different clips as sequence of images. The first frame of the video and still images appear as a thumbnail image.
4.4.3.2.3 Special Effects and Enhancements

- Import Media

Import media files to your current project selecting *Import Media* from the task pane and add them to the *timeline* or preview in the *preview area*.

- Title Clips

You can add a graphic and/or text to your project. Select *Title Clips* from the task panel and choose the properties for it. You can see your Title Clip in the preview area and insert it into the timeline.

![Adding a Title clip](image)

4.4.3.2.4 Record Camera: Add a Picture-in-Picture Recording

The Record Picture-in-Picture option captures video from the webcam and synchronizes it with the screen recording. Select *Record Picture* from the task pane.

Record using the *Start Recording* button and the *Stop Recording* button, you can change the *camera properties* and *video format* if desired.

You can see your video in the preview area and insert it into the timeline.
4.4.3.2.5 Voice Narration

Voice Narration is used to insert narration into the video using the playback of the clips on the Timeline as your guide. You can listen your narration in the preview area and insert it into the timeline in the position that you desire.

Select **Voice Narration** from the Task Pane and choose the different options to record using the **Start Recording** button and the **Stop Recording** button select the input source and control the correct volume.
4.4.3.2.6 Modify a Picture-in-Picture Recording

Select *Picture-in-Picture* from the task pane.

You can change the properties of your PIP, selecting the position, size, opacity, border and drop shadow. Fading, showing or hiding properties and remove a PIP not desired or all the current PIPs.

![Modify Picture-in-Picture (PIP)](image)

4.4.3.2.7 PIP Preview

Select where you want that the PIP windows will appear in your project. Select *PIP Preview* only one time per project when you produce your video.
4.4.3.2.8 Audio Enhancements

Use this function to enhance the audio tracks controlling the volume, removing the noise and optimizing the sound for male or female voice.

Select *Audio Enhancements* from the TimeLine and listen to your new audio in the *Preview area*.

4.4.3.2.9 Transitions

Select Transitions from the task pane. You can customize the transitions time selecting *Tools > Options > Transitions*.
You can insert transitions between your clips on the Timeline for the StoryBoard. You can see your changes in the preview area.

4.4.3.2.10 Callouts

Select Callouts from the task pane.

A Callout is a graphic that you can add to the Timeline so when the video is produced, the image appears within the video. Callouts are used to draw attention to an important object or process being shown on the screen. Combined with text, they can give additional tutorial or instructional information.

This function adds interactivity to your video.

You can customize the layout changing the color, font, opacity, size, text and import new ones to the current callouts.

You can view your changes in the preview area and customize the callouts time selecting Tools > Options > Callouts
4.4.3.2.11 Zoom-n-Pan

Select *zoom and pan* from the task pane.

Zoom in and out certain areas of the video, calling attention on your viewers,

Select the the region that you want to zoom, the zoom size, the speed of the zoom and the position by selecting the coordinates manually or with the mouse in the video view. You can view the result of the zoom in the *Preview Area*. 
4.4.3.2.12 Flash Quiz & Survey

Select *Flash Quiz* from the task pane.

Add ELearning interaction to your movie adding Quizzes or Surveys into your project when is produced as a Flash movie. It is possible to add multiple Quizzes and Surveys with multiple questions. Camtasia uses a SCORM-compliant output available in LMS applications.

Select the name of your quiz, the appearance and the quiz feedback options.

Select *Multiple Choice* or *Fill in Blank* for your questions.
Start to write your questions and the responses for your quiz and preview it in the *Preview Area.*

### 4.4.3.2.13 Captions

Select *captions* from the pask pane

You can add captions to the Timeline synchronizing text and audio where you have to paste a prepared script or manually into the scripting text box and set a caption point where you want to begin. You can preview your captions in the *Preview Area.*
4.4.3.2.14 Add Metadata Using the Project Properties

Select **File > Project > Properties**

Add information (called metadata) that describes the video. Information of the project like title, subject, date... Information about the author like creator, email, homepage... and information for the iTunes like summary, contain of explicit material...(in case you produce in an iTunes format).
4.4.3.3 Producing video

Once your project is ready, next step is to produce the final video and distribute it in a sharable format assembling all the video, audio and images of the timeline. This process is called rendering.

Select produce Video As... from the task pane. The Production Wizard will be displayed from which you can choose between three different options to produce the final video:

- Recommend my production settings
- Production Presets
- Custom production settings
4.4.3.3.1 Recommend my production settings

Select *Recommend my Production Settings* from the *Production Wizard*.

Choose the distribution method desired:

- **Web Distribution Production Option**
  
  Use this option to produce a video in Flash, Web-ready format. The output will include the files to upload the video creating a HTML file to launch the video in a web browser.

- **E-Mail Distribution Production Option**
  
  Use this option to produce the video in an E-mail in a friendly format. This option will open a new E-mail containing your video as an attachment.

- **CD Distribution Production Option**
  
  Use this option to produce the video in a CD-ready format. It includes an auto-run file to launch the video.
• **DVD-ready Distribution Production Option**

Use this option to produce a DVD-ready AVI format, encoding the audio with the highest quality.

• **Hard Drive or Other Distribution Production Option**

Use this option if you are not sure how you are going to distribute the video.

• **iPod or iTunes**

Use this option to create a video that is specially formatted to play on an iPod or with iTunes.

Note: You can only import Quizzes and Surveys with a distribution method that generates a Flash format.

Selecting the additional output options you can simultaneously produce an MP3 audio file with the audio on the Timeline, an iPod-ready video or to upload the original PowerPoint presentation so the viewers can download it from the Web.

For Web, E-mail, CD and Hard drive distribution you have to select the type of contents that your Timeline includes and that you want to produce by checking the correct option.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

### 4.4.3.1.1 Optimize File Size or Video Quality

Next step for *Web, E-mail, CD* and *Hard drive* distribution is to optimize the file size or video quality. Use the slider depending on if you want high quality or small size for your video.

You can also change the dimensions of your video if desired.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

**4.4.3.3.1.2 Optimize for File Size or Audio Quality**

Next step for *Web, E-mail, CD and Hard drive* distribution if your project contains audio is to optimize the file size or audio quality using the slider depending on if you prefer high audio quality or small size.

Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

**4.4.3.3.1.3 Flash Templates**

Next step for *Web, CD and Hard drive* distribution if you want to produce your project in a Flash format is to select the Flash template.
Choose the template that you want to use in your video determining how the video will appear. Select the position where TOC (table of contents) and/or PIP (web cam recording) will appear on the screen or do not choose them to appear.
You can also change the dimension and the size of your video if desired.

Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

### 4.4.3.3.1.4 Table of Contents

Next step for *Web, CD* and *Hard drive* distribution is to create a table of contents (TOC) for your video in Flash format if desired. Incorporating a table of contents provides an easy navigation point for the viewer and *Markers* and *Quizzes* may serve as bookmarks or placeholders within the video.

Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

### 4.4.3.3.1.5 Produce Multiple Files

For the *DVD distribution* is possible to produce separated video files based on the Markers on the Timeline.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

4.4.3.1.6 Save your video

For any type of distribution method you have to choose a *production name* and the folder where the project file will be saved.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

4.4.3.3.1.7 Completing your Production

The last step before completing the production process is to check that the settings of your video are correct. If they are not, you can modify these settings before rendering.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

When you select *Finish*, the rendering process will start running to create your video files.

![Rendering Preview](image)

4.4.3.3.1.8 Production Complete

After your video production is completed, you have the possibility to produce your video again changing the settings or if the settings are ok, continue with the selected distribution method options.

![Production Wizard](image)

Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

If your video production includes additional outputs as *iPod, PowerPoint, or MP3 files*, you can playback the video for your review.
4.4.3.3.1.9 Production Results

In the last step of the production process you can set the options for the selected distribution method and to create a Production Preset if you want to create more videos with the same settings faster and easier in the future.

Select the preview option to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

4.4.3.3.2 Production Presets

A Production file is a set of different information to produce videos with the same settings including Video File, Format, Encoding Options and Video Size.

Select Produce Video As... from the task pane and then select Production Presets from the Production Wizard. You can also create a Production Preset from the Production Results screen.
Choose a predetermined Production Preset, create a new one, edit or delete it from the Manage Production Presets wizard.
When creating a new preset or editing an existing one, you will have to configure its settings.

4.4.3.3 Custom Production Settings

Select the video format desired for producing if you want to create your video in a specific format by selecting *Produce Video As...* from the task pane and then select *Custom production settings*. 
You can produce in the following formats:

- **Adobe Flash (SWF/FLV)**

Adobe Flash is a cross-platform movie file format that plays on any computer that supports the Flash Player (ideal for Web delivery).

- **Windows Media (WMV - Streaming Format)**

The WMV file format is a Microsoft streaming file format that allows you delivering quality recordings with a smaller file size.

- **QuickTime (MOV)**

QuickTime is a video file format with a wide selection of video and audio compressors.

- **Audio Video Interleave (AVI) and CD-ROM Distribution**

The AVI file format is ideal for CD-ROM distribution with the highest quality.

- **iPod / iTunes**

iPod is a portable media player designed and marketed by Apple Computer to play exclusively on an iPod or within iTunes.

- **MP3 Audio Only**

MP3 or MPEG-1 Audio Layer 3 is a digital audio encoding and lossy compression format, designed to greatly reduce the amount of data required to represent audio.

- **RealMedia Streaming Media (RM)**

The RealMedia is a compression mode that optimizes your files for Web delivery using the standard RealVideo and RealAudio codecs to be reproduced with Real Player. Quality is often reduced for low bandwidth priority.

- **Camtasia for RealPlayer (RealPlayer Plug-In (CAMV))**

This file format uses the Camtasia for RealPlayer Plug-In to stream video with perfect lossless quality.

- **GIF Animation File (GIF)**

The GIF video format is used to publish short tutorials and product demonstrations that playback in any browser on any computer platform. GIF is also ideal for adding short animations to a PowerPoint presentation.
Selecting the *additional output options* you can simultaneously produce an MP3 audio file with the audio on the Timeline, an iPod-ready video or to upload the original PowerPoint presentation so the viewers can download it from the Web.

![Production Wizard dialog box](image)

### 4.4.3.3.1 Encoding Options

A variety of audio and video compressors and video codec are available for each format. Select the most suitable for your project. If you are not an advanced user, do not change the encoding options and select the predefined settings for an optimal quality of your video.
In case you want to produce in Flash format, you have also to select the appropriate template, dimensions and size for your video.

You can also select among different audio and video encoding flash options. Add a table of contents (TOC), change the playback controls or add a Flash action.

Select the preview option to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.
4.4.3.3.2 Video Size

Next step is to define the video size. This option is not for Ipod, MP3 and Flash formats because Ipod has a predefined video size, MP3 is only an audio file and in Flash the size was defined in the previous windows.

Select the preview option to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

4.4.3.3.3 Video Options

Next step is to choose the different options for your video. You can add Metadata, Watermark and Quiz reporting options and the possibility to embed your video for an easy web production. This option is not for Ipod and MP3 formats because Ipod has predefined video settings and MP3 is only an audio file.
Select the **preview option** to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

### 4.4.3.3.4 Marker Options

Select the **Marker Option** if you want to add interactivity to your video on the HTML page adding a Table of Contents and/or creating multiple files based on the markers on your Timeline. This option is not for *Ipod* and *MP3* formats because *Ipod* has predefined settings and *MP3* is only an audio file.
Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.

### 4.4.3.3.4 Produce Video

This is the final step before starting with the rendering process. Give a name to your production and the folder name where you want to save it. Select the *post production options* and check if you want to upload your production to ScreenCast.com for what you need to be a registered user.

You can also see the file names and types that will be created after the rendering process in this window.

Select the *preview option* to produce just a sample of the Timeline and see a thirty seconds video. This allows you to see how the video will look.
4.4.3.3.4.1 Batch Production

Select *Batch Production* from the task pane.

Produce several projects at one time using the *Production Presets*. Use the *Batch Production* to select the files or projects to produce.

Produce all the projects or files with the same preset or select a different preset for each file or project.

![Batch Production Screenshot]

4.4.3.3.4.2 Package a Video as a Pack and Show Executable File

Select *File > Pack and Show* and entry the path of the video that you want to pack. Depending on the format, you can choose between different options for each format and select the appropriate player.

This option creates an executable file; the video is launched when the user selects to unpack this file.

![Package Video Screenshot]
4.4.3.4 Other Applications in Camtasia Studio

You have the possibility to launch separately different tools to record, edit, produce and share.

Note: In this manual the functionality of these tools is not explained in detail, but you can find a brief introduction about them.

Select Start > All Programs > Camtasia Studio > Applications or select Tools from the main view of Camtasia Studio.

4.4.3.4.1 Camtasia Recorder

With this tool you can record the screen, apply real-time effects, zoom and pan, and import logos and graphs to the project.

Choose the part of the screen that you want to record, select if you want to add audio or camera recordings and press the Record button or F9 to start recording and press the Stop button or F10 to stop recording.
You can also add effects to your recording, like *zoom and pan* in a specific region screen or add *annotations* and sounds to your recorded video.

Select *Effects > Options* to configure effects.
4.4.3.4.2 Camtasia Audio Editor

With this tool you can edit your project, add voice annotations, sound effects, import audio tracks on an image or video and regulate the volume level.

4.4.3.4.3 Camtasia MenuMaker

With this tool you can create menus to launch different files for distributing your videos or other files. The files are located centrally, making it easier to open and close. You can also create a CD-ROM that will automatically launch the menu.

Choose a template for your menu interface.
Choose the files to include in the menu, you can add as many files as you want in different formats like video, sound, image, text document or executables.

Next step is to title the menu and customize it with the adequate format and colours. After that, you can test your menu and if it is ok, you are ready to create it. Write the path where you want to save the files and it is ready.
4.4.3.4.4 Camtasia Theater

With this tool, you can create an interactive menu for Flash files to distribute it afterwards and navigate easily through your videos.

Edit how your menu will look selecting the most appropriate colours, font, alignment, width and add the Flash movies that you want to export to the *Flash Menu*.

You can also set the options for pausing and playing, change the controller color, the duration properties and preload a movie from the controls view.
Select *Export Flash Menu*, choose a folder where to save the menu and the menu will be exported.

**4.4.3.4.5 Camtasia Player**

With this tool you can play your AVI videos in different sizes and change their codecs.
5. RESULTS

With the fast growth of the market for eLearning tools, the familiar tools like Powerpoint are used for a lot of developing teams to create instructor-led material adding the possibility to convert in different formats like Flash for delivery in the Web or on a CD-ROM.

For years PowerPoint has been a mainstay of the presentation technology used in the classroom to assist in the delivery of instructor-led material. It has become a solid tool, providing an outline view, a notes view, drawing tools, animation, sound and video. In my experience, this is everything needed to develop basic eLearning content, except for Web capability.

Instructional designers are creating eLearning developing. They should need to have more skills in different areas to create an eLearning project, but technologies like Flash provide an alternative because they don’t need to learn different applications or programming languages and they can add animations or narration to their eLearning presentations and add it in the Web or in an LMS with the tools presented in this document.

There are specific features to the tools presented in this document:

- Creation and organization of the visual content display, it is easy to coordinate the design and the content that you want to add to the eLearning content and is also supported by Powerpoint.

- It is so easy to create all kinds of animations, interactivity with a lot of possibilities creating narration or video, recording the screen, adding audio, images… and having the possibilities to edit in a time-line to create the material professionally designed.

- Convert the eLearning material into different formats and deliver it via web where it is accessible to all kinds of users or just package it inside a more complex tool like LMS or LCMS.
6. CONCLUSIONS

After working in this thesis I have realized how the learning methods have changed not only into the market world, but also into normal learning institutions, like universities, high schools or academies. Many web pages have grown teaching eLearning and it is difficult to think on actual academies which have not included some kind of help in this environment. The companies rarely offer to their workers other methods due to their cheap cost and their proven results.

Teachers can now offer their contents in many different ways. It opens opportunities to all those people who want to share their knowledge with the rest of the people, and also to all the private sectors that search a new market.

The old methods of learning have been overwhelmed by a more effective and efficiency way to all those who search knowledge.

Nowadays I can recognize in my daily work all those symbols of eLearning. In my work we use PowerPoint and videos for teaching knowledge between departments; we make online courses with a lot of people distribute all around the world at the same time; I need to use tools like camtasia to create and distribute courses about my work and about issues related to my work, like problems to be solved or presentations of new tools.

It’s been curious to see first-hand information about eLearning in the real world, in an international company which think about the eLearning as a big asset. It’s really difficult to imagine in a world without the power of distance learning, like as a said, we use in the company all the time.

I have realized how complex is the organization of the difference companies and associations to get them agree about the standards to use. How would it be possible the high growing of eLearning without the participation of such complex organizational structures? It would be more probably buried down in the oblivion, or maybe it would be more complex, losing that compact-feeling that actually it has.

I believe that the eLearning industry holds much promise for profitable investments over the coming years. However, given the immature state of the industry, the wide array of target markets and the difficulty of keeping up with changes in learning technologies, I think that discrimination is warranted. Careful research must be undertaken in order to determine which companies will eventually emerge as winners.
7. REFERENCES

Articles

[4] David P. Beach, E-Learning (A web based education system), Amazon, United States

Books:

Web Pages: